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Chapter 1. System requirements and
compatibility

Unica Journey is part of the Unica suite of products. Unica Journey version 12.1.1 requires
Unica Platform 12.1.1.

Where to find complete system requirement and compatibility information

For a list of Unica product versions compatible with Unica Journey and a list of third-party
requirements for this product, see the Recommended Software Environments and Minimum

System Requirements document.

You can also access this document by selecting Help > Product documentation when you

are logged in to Unica.

Prerequisites for using Unica Journey

Before you begin using Unica Journey, confirm that your environment meets the following

requirements:

« For an improved user experience, use at least a 21-i nch screen.

« For an improved user experience, set your screen resolution to 1600x900. Lower
resolutions can result in some information not being properly displayed. If you use a
lower resolution, maximize the browser window to see more content.

« Amouse is best for navigating in the user interface.

« Do not use the browser controls to navigate. For example, avoid using the Back and
Forward buttons. Instead, use the controls that are in the user interface.

« If pop-up blocker (ad blocker) software is installed on the client machine, Unica
Journey might not function properly. For best results, disable pop-up blocker software
while running Unica Journey.

« Ensure that the technical environment meets the minimum system requirements and
the supported platforms. For more information, see the Recommended Software

Environments and Minimum System Requirements document.
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» The correct browser and versions must be used. For more information, see the

Recommended Software Environments and Minimum System Requirements

document.

- Clear the browser cache after installation. This only needs to be done once, after the

application is updated.

Important: Do not use any other method to open multiple sessions. For example,

do not open a new tab; do not open another browser session from the Start menu

or desktop icon; and do not use File > New Window in Microsoft Internet Explorer.

These methods can corrupt information that is shown in the application.

Unica Journey documentation roadmap

Unica Journey provides documentation that helps users like marketers, administrators, and

developers to get their hands on the product functionality.

Table 1. Get up and running

Task

Documentation

Find out about the new features in the
product

For the first release, all new features are

available in the Unica Journey User Guide

Find out about the known issues and limi-

tations

Unica Journey Release Notes

Learn about the structure of the Unica

Journey system tables

Unica Journey System Schema

Installation and configuration of Unica

Journey

Unica Journey Installation Guide

Upgradation and configuration of Unica

Journey

Unica Journey Upgrade Guide
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Table 2. Installing and Configuring Unica Link

Task

Documentation

Installation and configuration of Unica
Link

Unica Link Installation Guide

Installing Unica Link connector app for

Journey

Unica Link Installation Guide

Installing Unica Link connector -
MailChimp

Unica Link Mailchimp Connector User
Guide

Installing Unica Link connector — Mandrill

Unica Link Mandrill Connector User
Guide

Installing Unica Link connector — Twilio

Unica Link Twilio Connector User Guide

Installing Unica Link connector — Sales-

force

Unica Link Salesforce Connector User
Guide

Table 3. Integrate Unica Campaign with other HCL products

Task

Documentation

Integration of Unica Campaign and Unica

Journey

Unica Campaign Administration Guide

and Unica Campaign User Guide

Integration of Unica Campaign and Unica
Interact

Unica Interact Administration Guide

Integration of Unica Deliver with Unica

Journey

Unica Journey User Guide

Integration of Unica Centralized Offer

Management and Unica Journey

Unica Journey User Guide
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Table 4. Get Help

Task Documentation

Unica Journey documentation You can get Unica Journey product doc-
umentation while you logged in Help >

Product documentation.

Unica Journey when installed with other Unica suite products

Before you start installation of Unica Journey you can refer to below sections to plan

Journey installation.

Unica Journey delivery engines for Email

Unica Journey supports Unica Deliver and Unica Link for email delivery. You can use any of
these integration as per your requirements. Please refer to documentation map section for

appropriate documents to refer on this integration.

Unica Journey stack support

Unica suite product support to third party software like databases, operating system,
application server etc., is not exactly same support with Unica Journey. Please refer to

Recommended Software Environments and Minimum System Requirements guide.

For example, If your existing Unica products are installed on stack as below:

* Operating System - AIX 7.1
« Application Server - WebSphere
« Database - DB2

You can install Unica Journey on supported environments as mentioned in Recommended
Software Environments and Minimum System Requirements guide and it would be

compatible with existing Unica products.

Upgrading Unica products and Installing Journey

If you are upgrading from older Unica product version to 12.1.1, you can complete your

upgrade and then install Unica Journey 12.1.1.
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Where to find documentation
You can find the documentation here.

 PDFs: http://doc.unica.com/products/index.php?
showFolder=RW50ZXJwcmlzZQ==&folder=aW50ZXJhY3QvMTJfMV8w
« Online Help: https://help.hcltechsw.com/unica/Journey/en/12.1.1/index.html


http://doc.unica.com/products/index.php?showFolder=RW50ZXJwcmlzZQ==&folder=aW50ZXJhY3QvMTJfMV8w
http://doc.unica.com/products/index.php?showFolder=RW50ZXJwcmlzZQ==&folder=aW50ZXJhY3QvMTJfMV8w
https://help.hcltechsw.com/unica/Journey/en/12.1.1/index.html

Chapter 2. Prerequisites for Unica Journey
Installation or Upgrade

Before installing Unica Journey version 12.1.1, you have to ensure that a few prerequisites

are met.

If a you are a new user, and if you have HCL OneDB, MariaDB, or Microsoft SQL Server as the
database, you can directly install Unica Journey 12.1.1. Ensure that Unica Platform version

12.1.1 is operating correctly.

The supported upgrade path for Unica Journey 12.1.1 are as follows:

Table 5. This table describes the topics that are included in the Unica Journey

Upgrade Guide and the list of sub-topics in the second column.

Base Journey version Upgrade path Tasks to be performed
Unica Journey 12.1.0 or In place upgrade to Unica 1. Upgrade Unica Mar-
12.1.0.x (with system ta- Journey 12.1.1 keting Platform to
bles on Oracle, MS SQL 12.1.1

Server, OneDB, MariaDB) 2. Run upgrade Unica

Journey to 12.1.1 in-
staller

3. Configure Journey
application

4. Deploy Journey appli-
cation

5. Run Journey applica-

tion
Clean Installing Journey on | In place upgrade to Unica 1. Upgrade Unica Mar-
existing Unica environment | Journey 12.1.1 keting Platform and
when you have system ta- required Unica prod-
bles as OneDB, MariaDB ucts to 12.1.1 except

and SQL Server databases Journey.
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Table 5. This table describes the topics that are included in the Unica Journey

Upgrade Guide and the list of sub-topics in the second column. (continued)

2. Run clean installer of
Unica Journey 12.1.1

3. Configure Journey
application

4. Deploy Journey appli-
cation

5. Run Journey applica-

tion

Note:

1. If users do not have Journey already installed on existing Unica environment
with Oracle database, then they need to install Journey version 12.1.0 and
then upgrade Unica Journey to 12.1.1

2. If you do not have Journey already installed on existing Unica environment
with either MS SQL Server, OneDB or MariaDB database then you can install

Journey version 12.1.1 directly as clean install.

To prerequisites for installation, or upgrade, of Unica Journey are as follows:

1. Ensure that all users are logged out.

2. Stop Unica Journey, Unica Platform, and all applications that are deployed with it.
Also, stop all other components, for example Journey Engine, Kafka server, etc.

3. Undeploy Unica Platform and Unica Journey web application from the application
server.

4. Stop the application server and clean the application server cache.

5. Back up the Unica Platform and Unica Journey database and file system directory to

any temporary directory.



Chapter 3. New features and changes in
version 12.1.1

In Unica Journey 12.1.1, we have introduced some new features, and we have made

changes to some existing features or functionality.

The following list mentions the support for new platforms, in Unica Journey 12.1.1:

* Supports IBM WebSphere Application Server and Red Hat JBoss Enterprise
Application Platform.

« Supports Kafka on windows operating system. To configure Kafka on
Windows operating system, see https://support.hcltechsw.com/csm?
id=kb_article&sysparm_article=KB0085551.

The following list mentions the new features, and the changes to existing features, in Unica
Journey 12.1.1:

- Offer Integration with Journey

Journey supports offer from Centralized offer management. In Journey application
user can associate offers with Deliver communication and also with the Journey
touchpoints sent across through Link connectors. Journey supports Deliver Offer
Integration, Link offer Integration and Interact Next Best Offers (NBO).

« Contact History and Response history (CH/RH) tracking

Contact history and Response history (CH/RH) for the offers delivered from Journey
will be tracked in Centralised history (CH) table of Campaign. Offer delivered by
Delivery Email channels, Link connectors or by interact using link delivery channels
are recorded for CH/RH tracking. This tracking is done under respective Campaign
Contact history tables.

- Save Journey Templates

Marketer are able to save journey as template and create Journey from a saved
templates.
« Support Microsoft Edge Browser


https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0085551
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0085551

Unica Journey V12.1.1 Release Notes | 3 - New features and changes in version 12.1.1 | 9

Journey supports Microsoft Edge Browser for all Unica product

« REST Touchpoint Support for Journey

Marketer can call external RESTAPI, so that other systems can be called in realtime
for orchestration.

« Export/Import of Journeys

Export/Import of Journeys feature enable user to take Journey from one instance and
deploy it on another instance.

« Upgradation from Swagger2 v2 to OpenAPI 3.0 v3

REST API documentation part will be upgraded from Swagger2 specification to Open
API Specification (OAS) 3.0 through Swagger tool.
« Expression Builder for Delay touchpoint

Expression Builder for Delay touchpoint should accommodate DD field +- days

- Configurable Max No of Days in Delay

User can now configure Max No of days in Delay, Engagement split and Decision split

« Sample Journeys

Sample Journeys are provided, which users can as exported output files.

« Journey Support Unsubscribe Events

Journey support Unsubscribe events in Journey through deliver. If a user wishes
to unsubscribe from Journey emails, we will track them through unsubscribe and
Journey will not send any mails to these users in future.

« Journey Accelerators

Journey Accelerators are prebuilt industry specific Journeys available in 12.1.1. These
Journeys are built keeping customer experience in mind. These journeys will inspire
marketer to create similar experiences in their environment. For more information,.

see Journey Accelarator 12.1.1



Chapter 4. Fixed Defects

The following table lists the defects fixed in Unica Journey 12.1.1:

Defect ID Description

HMA-327882 REGBB- For Past date on Engagement split - validation mes-
sage should be shown while publishing journey

HMA-327896 (IE browser) -REGBB- On goal analysis page after changing
frequnecy it takes long time to get bars available on page

HMA-327965 Audience page - Last date shown on X axis is missing its
position for Last 12 months and daily frequency

HMA-327967 Pause and Republish - Journey should not be allowed to re-
publish when decision split has wait till date in past

HMA-318951 If kafka service is down and user uplaoad the entry source
file - after restarting kafka its showing some more records in
statistics view

HMA-327810 Configuration Parameters missing from Journey documen-
tation

HMA-328091 One DB - French user - User not able to save/configure any
journey controls

HMA-328253 Intermittent issue - Sometimes configured decision split
evaluation configuration gets unconfigured while pause and
republish cases. Also observed sometimes for draft jour-
neys

HMA-328358 Decision Split stats count shows wrong count due to dupli-
cate audiences

HMA-328505 REGBB- german user- Journey canvas palette option names
are distorted
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Defect ID Description

HMA-328743 Count of total audiences sent and audiences inserted do not
match

HMA-329218 SMS Deliver Template selection screen - Not able to scroll

through the templates

HMA-330194 REGBB- After achieving date based goal - Journey is not get-
ting completed for date based goal

HMA-330089 REGBB- Showing wrong date (extra one day) on warning
message while publishing the journey with delay and date
based goal

HMA-329960 REGBB- On Goal Analysis page for custom date range its

showing records which are not fit in that date range

HMA-329953 REGBB- After pausing the journey with some date based
goal, its showing message of Target Completion date is

smaller - though its greater

HMA-329927 REGBB- On stats showing duplicate rejection count

HMA-329278 REGBB- In CSV file having 999 records - and journey is pro-

cessing more records i.e. greater than 999

HMA-329621 REGBB - Upgrade journey - Engagement Split touchpoint is

shown unconfigured when journey is paused

HMA-329604 REGBB- Email open and link click events of Deliver and Link
is not getting available on journey touchpoint stats




Chapter 5. Known issues

The following table lists the known issues in Unica Journey 12.1.1:

Defect ID Known Issue

HMA-330271 NBO -Offers attributes created by partition2 user are not
available for mapping

HMA-330006 REST touchpoint need performance improvement

HMA-329866 In offer selected page if variant offer is selected master of-
fer name is displayed

HMA-329714 Link and Deliver Offer : When an offer email is sent to same
customer again, CH-RH tables are not populated again

HMA-329567 LinkOfferIntegration - OfferEffective date = Flowchart run
date. Effective date should be the date when audience
lands into the email touchpoint

HMA-329544 An Error observed when selected undeployed IC on NBO
Screen

HMA-329318 Deliver-Offer- In draft journey User not able to save deliver
touchpoint if user adds same offer multiple times in deliver
communication

HMA-329149 Journey_Deliver Integration - Used Templates are not get-
ting displayed for reuse

HMA-330228 Upgrade Test - Old journeys not showing goals progress,
events shown on stats, even though no data was pushed

HMA-330419 Distributed Environment: Engine application properties kaf-
ka bootstrap server details are not updated which provided
while installation.
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Defect ID Known Issue

HMA-330418 Client ID and Client secret ID not getting updated in Engine
application.properties

HMA-330228 Upgrade Test - Old journeys not showing goals progress,
events shown on stats, even though no data was pushed.

HMA-330152 Journey web and engine application properties couple of in-
correct values update.

HMA-330092 KafkaStandalone - Server.properties and Engine application
properties files need some change in some properties.

HMA-329165 Import Journey - Link to track is not retained for Engage-
ment Split and Goals for Deliver touchpoint and engage-
ment split is shown as configured.

HMA-328036 Data gets rejected in case of data refresh update contact
setting when updated data is passed back to back multiple
times which seems confusing to the user.

HMA-327916 Goal Analysis - When Date changes to next date - if user
available on Goal analysis page - data refresh not happen-
ing.

HMA-327906 REGBB- Date standerization - Journey with time zone 'Amer-
ica Santigo' for daily frequnecy goal showing one more ex-
tra day on X axis.

HMA-327853 Unique constraint (informix.unique_cachekeynamehash) vi-
olated error displayed quite frequently in both web and en-
gine logs.

HMA-327636 Average Goal complete rate calculation needs to be en-
hanced for more clarity

HMA-330726 Error(7,5): PLS-00114: identifier'R_LJOURNEYGOALCON-

TACTTRANSACTIO' too long error displayed on oracle 12c
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Defect ID

Known Issue

for v12.1.1 while executing the scripts JourneyOracleS-
toredProcTrigger.sqgl for PROCEDURE process_journey_-

goals_hist

HMA-330727

ORA-02264: name already used by an existing constraint
displayed while executing the JourneyReportOracleCreate-

Tables.sql on oracle 12c on single schema for Journey

HMA-329134

While installing journey its giving warning message regard-

ing space availability with random numbers




Chapter 6. Before you contact HCL technical
support

If you encounter a problem that you cannot resolve by referring the documentation, your
company's designated support contact can log a call with HCL technical support. Use these

guidelines to ensure that your problem is resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your HCL

administrator for information.

Information to gather

Before you contact HCL technical support, gather the following information:

« A brief description of the nature of your issue.

« Detailed error messages that you see when the issue occurs.

« Detailed steps to reproduce the issue.

« Related log files, session files, configuration files, and data files.

« Information about your product and system environment, which you can obtain as

described in "System information."

System information

When you call HCL technical support, you might be asked to provide information about your

environment.

If your problem does not prevent you from logging in, much of this information is available

on the About page, which provides information about your installed HCL applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, check foraver si on. t xt file that is located under the installation directory for

your application.

Contact information for HCL technical support
For ways to contact HCL technical support, see the HCL technical support website:

https://www.hcltech.com/products-and-platforms/contact-support


https://www.hcltech.com/products-and-platforms/contact-support
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